Projector Messenger Tool
Ver.1.5.0
Instruction Guide
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1 Introduction

1.1 Outline

Projector Messenger Tool is application software used when the messenger function is used with the projector.
PJMessenger provides the ability to:

X The message edited in the editor is transmitted to the projector by way of the network and it preserves it.
X Display On/Off and the deletion of the message registered in the projector are executed.

X The alarm registered in the projector is played in sync with the message.

X The message data send button can be locked using a password.

[Note]
In order to send the Message to the projector, the computer needs to connect the network and be able to
communicate with the projector. Please see ‘User’'s Manual-Network Functions’ for the details.

Please see ‘User's Manual-Operating Guide’ and ‘User’s Manual-Network Functions’ about Messenger
functionality.

1.2 System

The following diagram shows a typical network diagram for the Projector Messenger Tool.

LAN LAN

LAN LAN

[An) = [An) =1 3 =1 [An)

—

Projectors

» Use a UTP cable category 5 or higher for a Local Area Network cable.



2 Installation

2.1 System Requirements

The following are the minimum system requirements of hardware and software to use the Projector Messenger
Tool

(1) Operating System
Windows 2000 Professional
Windows XP Home Edition (32-bit)
Windows XP Home Professional (32-bit)
Windows Vista Home Basic (32-bit)
Windows Vista Home Premium (32-bit)
Windows Vista Business (32-bit)
Windows Vista Ultimate (32-bit)
Windows Vista Enterprise (32-bit)
Windows 7 Starter (32-bit)
Windows 7 Home Basic (32-bit)
Windows 7 Home Premium (32-bit)
Windows 7 Professional (32-bit)
Windows 7 Ultimate (32-bit)
Windows 7 Enterprise (32-bit)

(2) CPU
Pentium3 500MHz or higher

(3) Memory
128MB or higher

(4) Hard Disc
Minimum 20MB free space for installation.

(5) Local Area Network port (RJ-45)



3 Function

3.1 Abstract

The messenger function is the one to transmit the message (text data) to the projector by way of the network,

and display the character data transmitted on the screen of the projector.

[Image]

Today’s Topics

The chemical class is canceled

The PE is performed at gym
today due to bad weather

The display style can be selected from 3 styles (Scroll / Box / Pop on).

Please refer to the following for each detail.

1) Scroll S ,
The message text is displayed by a horizontal scroll. The chemical class is cance
It is suitable for reducing the influence on the image displayed or the

display of short sentences.

2) Box
The message text is displayed by a vertical scroll.

It is suitable for the display of long sentences. Today’s Topics
The chemical class is canceled
The PE is performed at gym

today due to bad weather




3) Pop on

The message text is popped on the screen all at once. The blinking

Today’s Topics
- The chemical class is canceled

operation is possible though there is no movement such as scrolls.

It is suitable for the display of sentences to want to pay attention. S The PE is performed at gym

' today due to bad weather
(etc. alarm) :

4) Picture Side

Topics
The
models. When not native aspect signal such as 4:3 is input to [l

class is

This function is only available for wide aspect ratio panel

wide aspect ratio panel models, right and left hand sides are
canceled

non-image display area. The message text is displayed in this [EAFSZESY
performed §

non-image display area. In this case, displayed image can be t
at gym

shifted to right or left hand side.

If you select text display at left hand side, image display

moves to right hand side. On the other hand, right hand side is Topics
selected for text display, image display moves to left hand I:eemical

side. o s is
e canceled
& The PE is

performed
at gym

3.2 Supported language

The example of the language that can be displayed is shown below.

e.g. English, French, German, Spanish, ltalian, Norwegian, Dutch, Portuguese, Swedish, Finnish, Danish,
Brazilian Portuguese, Indonesian, Lithuanian, Estonian, Latvian, Polish, Czech, Hungarian, Slovak, Croatian,

Russian, Turkish, Greek, Japanese, Chinese (Simplified), Chinese (Traditional), Korean, Vietnamese.



3.3 Each part name

The name of each part is defined as follows.

1) Scroll 1. Message display area

Today’s Topics
The chemical class is cance 2. Title

3. Message text

. Image display area

2) Box
1. Message display area

o Today’s Topics

£% The chemical class is canceled

The PE is performed at gym

today due to bad weather

. Message text

. Image display area

3) Pop on

1. Message display area

CAUTION !

Immediately, Turn off the
rojector main switch.

3. Message text

. Image display area




4) Picture Side

1. Message display area

Topics
The

chemical 2. Title
class is | 5 ——

canceled S T :
The PE is B : 3. Message text
performed .

at gym = \
4. Image display area

1. Message display area
It is an area where the message is displayed. The color can be set. Please refer to “3.9 Character color” for

details.

2. Title
The title of the displayed message is displayed. The title is displayed by a line. Moreover, the character color

and the character background color can be set. Please refer to “3.9 Character color” for details.

3. Message Text
The text of the message is displayed. The character color and the character background color can be set.

Please refer to “3.9 Character color” for details.

4. Image display area

It is an area where the image is displayed.



3.4 Display style

The display style can be selected from 3 styles (Scroll / Box / Pop on).

Please refer to the following for each detail.

1) Scroll

The title is displayed in the first line, and the message text is displayed

in the second line.

Only the message text scrolls to the left. The title doesn't scroll. = “:};-"‘i-f—*ﬁ-b—:-m—'*‘"'
Only the message text is displayed by one line when there is no title. % :

It is also possible to set the scroll times, and to turn off the display by

the automatic operation. Moreover, it is also possible to set the speed

of the scroll from 3 types (slow/standard/fast).

2) Box (Scroll up)

The title is displayed in the first line. The character scrolls in the

message display area. Even if the screen changes by the vertical scroll R NEVER TS

of the message text, the title is always displayed. § The chemical class is canceled

B The PE is performed at gym
The display time can be set, and the display be turned off by the | ReEEMEOERNELREEES

automatic operation.

3) Pop on

The title and the message text are displayed all at once.

The title is displayed in the first line. The message text is not scrolled.

CAUTION !l

The display time can be set, and the display be turned off by the E

Immediately, Turn off the
projector main switch.

automatic operation.
Moreover, the blink setting can be set. When the blink setting is turned

on, the interval is [1 second: non-display / 3 seconds: display].

10



4) Picture Side
The title is displayed in the first line. The character scrolls in the

message display area. Even if the screen changes by the vertical scroll

of the message text, the title is always displayed.
Depending on the combination with input signal aspect ratio, “Picture

Side” texts might be displayed over the image. In that case, you can

make “Picture Side” invisible. Push “down V¥~ button on remote or

select “down ¥”in OSD while “Picture Side” is displayed.

[Note]
When Picture Side function is enabled, the title will not be displayed completely depending upon the length

of title or other projector settings.

3.5 Display mode

1) Quick
It immediately displays transmitted message without saving the message data. When AC is turned off, the

message data is deleted. (It is not deleted when the projector stays in the standby mode.)
2) Saved number
The message is saved in the memory in the projector. 12 pieces can be saved.

Even if the main power is turned off, the message is not deleted.

Therefore, it makes possible to display the message only by setting saved number.

3.6 Display position

1) Horizontal position (Scroll / Box / Pop on)

A horizontal position of the “Title” can be selected from 3 styles (left/center/right). The position cannot be

chosen about the “Message text”.

Left Center Right

Today’s Topics Today’s Topics Today’s Topics
The chemical class is cance The chemical class is cance The chemical class is cancg

11



2) Vertical position (Scroll)

The vertical position can be selected from 3 styles (upper/center/lower).

Upper Center Lower

Today’s Topics
The chemical class is cance

Today 5 Toplcs

The chemical class is cance

oday’s Topics
The chemical class is cance

3) Vertical position (Box/Pop on)

The vertical position can be selected from 3 styles (upper/center/lower).

Upper Center Lower

Today’s Topics
The chemical class is canceled.
The PE is performed at gym

today due to bad weather Uy ajelles

The chemical class is canceled. g
The PE is performed at gym
today due to bad weather ?

Today’s Topics

The chemical class is canceled.
The PE is performed at gym
today due to bad weather

4) Horizontal position (Picture Side)

The Horizontal position can be selected from 2 styles (Left/Right).

Left Right

Topics Topics
The The
chemical chemical
class is § S e —— : S EMENE e e e Cl2SS S
canceled e e e e Sz g i e S canceled

The PE is [ D e ek -
performed SRS = — R B performed
at gym — e e — ——— e at gym

12



3.7 Titleicon

[+ .
L!j_'JToday's Topics
The chemical class is cance

The icon can be inserted in the title.

Please select it from the following five icons.

QLD

3.8 Character font size

The character font size to display can be chosen from two, Standard/Double size.

3.9 Character color

The character color, the character background color, and the background color can respectively be chosen
according to the following nine colors.
Black/ Red/ Blue/ Green/ Cyan/ Magenta/ Yellow/ White/ Half transparent black

It is possible to color in each character. (character color and character background color)

The background color sets the color of the message display area. The

background color of the title and the message text becomes the same

color.

The example of the scrolling display is shown right.

[Character color: Red / Character background color: Blue / Background |~ ._'

color: Green]

13



3.10 Character limit

1) Title

Max 40 characters can be input by a standard character font size, and Max 20 characters can be input by a
double character font size.
[Note]

» The data of 128 bytes is the maximum in the title. When character color/character background color is set,
the data for color information will be added further. Therefore, when the character color is set, it becomes
less than 40/20 characters. Please refer to the following * character data computational method for the
data size of message computational method.

> When Picture Side function is enabled, the title will not be displayed completely depending upon the

length of title or other projector settings.

2) Message text

The data of 3968 bytes is the maximum in message text. When character color/character background color is
set, the data for color information will be added further. It is 1916 characters or less when only one color is
used, but it decreases less than 1916 characters when the character color is set. Please refer to the following *

character data computational method for the data size of message computational method.

<Character data calculate method example>

First of all, control header (6byte) that includes color information in beginning is added. Afterwards, the
character code (Unicode) continues. And then if the character color is changed, control header (6byte) is
added in addition. The terminate code (2byte) is added to the terminal of the message, and it becomes an end

of the message data.

The example of calculating the data size is shown below (when “Today" is input).

Ex 1) Today (all black characters with white background)

Control Character Character T ‘0’ ‘d’ ‘a’ Yy’ Control
code color(Black) background Code
color(White)
[00][1B] [00][00] [00][07] [00][54] | [OO][6F] | [00][64] | [00][61] | [00][79] | [00][00]

The data size is 18 bytes for example 1).

14



The next example when one character color is changed is shown below.

Ex 2) Today (“d” is only red character and remaining characters are all black with white background)

Control Character Character ‘T ‘o’ Control Character Character ‘d’
code color(Black) | background code color(Red) | background .
) ) Continues to the
color(White) color(White)
[00][1B] | [00][00] [00][07] | [00][54] | [0O][6F] | [00][1B] | [00][01] [00][07] | [00][64] next line.—
Control Character Character ‘a’ 'y’ Control
Continuation from the former code color(Black) | background code
color(White)
line—
[00][1B] [00][00] [00][07] [00][61] | [00][79] [00][00]

The data size is 30 bytes for example 2).

As mentioned above, 12byte (control header 6bytex2) data size will increase when the character color is

changed only by one character.

3.11 Level

The projector displays the NO INPUT IS DETECTED message (hereafter, NO INPUT message) etc.
displayed in the menu, the alarm message, and the state of non-input with OSD on the input image.

This is setting to decide the priority level of the display item.

The display level can be selected from 3 styles (low/middle/high).

Please refer to the following for each detail.

1) High: neither menu OSD nor the alert messages are displayed.

[Note]

» There is no method of turning off the message except that the application software is used to turn off the
message when Messenger is not set with My Button. Please refer to the projector manual attachment for
the setting of My Button.

>  While the message set at High-level is displayed, all buttons except STANDBY/ON button are invalid.

2) Middle: NO INPUT message is not displayed. Just the message is displayed.

3) Low: After the NO INPUT message is displayed for five seconds, the message is displayed.

15



3.12 Startup Display

In specified minutes after AC is turned on or return from stand-by mode, stored message in projector memory
is displayed. This function is not available at “Quick” display mode. You can select the display message from
12 stored ones by “Saved number” as described in “3.4 Display mode”.

You can also set this function at the same time when you newly send the message to projector or store into

projector.

3.13 Caution

1) This messenger function and C.C functions cannot be used at the same time. Please turn off the message

to display C.C because the priority of the message is set high.

2) When direct keys such as Magnify, Freeze, and Position are operated while this function is used, it becomes

invalid. Please turn off the message when using it.

16



4 Alarm

4.1 Outline

The Alarm function is the one to sound the alarm at the same time when the message transmitted by way of
the network is displayed with the projector.

Please use this function when you want to display the message that you want to show particular attention to.
These alarms can be selected from four types of alarm registered in projectors.

Today’s Topics

= The chemical class is canceled Sl

The PE is performed at gym
today due to bad weather

The following is the alarms registered in projectors.

1) Sound Number 1 [ The alarm sound : pipipipi... ]
2) Sound Number 2 [ The warning sound : beee... ]
3) Sound Number 3 [ The start-up sound : pooon]
)

4) Sound Number 4 [ The campus broadcasting sound : Pin — Pon — Pan - Pon]
Moreover, it is possible to set following option to these above alarm.

1) Volume [low/mid/high]

The volume of the alarm can be selected from low/mid/high.
[Note]

This volume is not synchronized with the volume of the projector. Please note it.

Even if you mute the projector, these alarms is played by the specified volume.

2) Loop [endless/1/3/5]

The alarm time is selected from endless/1/3/5.

3) Interval [0-5sec]
Time from the end of the alarm the next alarm can be selected.

You can select from 0 second to 5 second.
17
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5 Install

5.1 Projector Messenger Tool Installation

The installation process of Projector Messenger Tool is as shown below. Please follow each step.
(1) Doubile click the file “InstForPJMessenger.exe”.

(2) Click [Next]

Projector Mirssamper Tool - letaltShield Wizard 3

Wkcomes 1o e Imaballs hisld] ‘i I
Mogscton Mscsenges | ool

T bkl ek 'winand wall mastisll Progescion Weapenges
Tl o ot compaater. 1 conbras, chok Mast

(3) Read “License Agreement” and select “I accept the terms of the
license agreement” and click [Next] if you agree the license Lo haoement g’ |
agreement. Otherwise, click [Cancel] and stop the installation. i ——

Projecior Merssnger Teol - letaltShield Wisard

Leceres Agponrend

Mibcha Comaumnes Diecionecn Co, Lid

T et Cissboamas .l e

Bl e i ]t lbowor'sy “Liirod Aspinirand™ £

by
[y intaling anc'on g of el iofwane. you agree B0 i Licenie

Ageerert
M s chy R e s s Lot Aersrmd. ous i 01T shicaest b inatsll sncdtor
et otese

1. "Vions gy st i it e s homa o B Licomoons Axgrosman -

(211 gt Woe tewma o e fcerne ageemment Fred
(1 gt et g B el T e gt T

(4) Confirm the program folder, and then click [Next].

Projector Messanger Tool - lastalShield Wizard
Chese Desnaton Location “
Sekoct bokdor ebwre: sotug vl et St
et Pregoctes Mestserges Teolna
A "Frepmoten Toock\Prooctcs Mistoerges Teed Drrge

19



(5) Confirm the install folder and program folder again, and then
click [Next].

Profecior Messanger Tool - leatalShield Wizard

Select Progess Felder y ‘
Pleate stioet a g fokde

'Smd-lddww-mhhha- Fokien lotesd babosss "ioas masgy bypos & v bk
e, O ieplencR ey e iy Gootiny) Kolion et (CICH, R b corfinue

Evegrom Foiler
ogector Tz

gt Fikders

Profecior Messanger Tool - leatalShield Wizard
Stail Coppng Files | ‘
Flevate oot befiee Sogyr e

Satp b sncgh romutin mhm—&n ¥ yous veank b arveee 0
anwhﬁ. ¥ s e ittt i, cleh, Het b b

I:I-rlhlhul

Ciadrater ot

- Progrem Fles \Propcion ool Propscion Messengss Todl
Fi

s T

Projector Marstimnper Tool - fetaltih
Setup Stalu

T his bt alfhakd Wiz @ ratalling Prosscior Marsarger Tosl

Tristalieg
£ \Promcion TooliPomcion Memsnge ool i
|IIIIIIIIIIIIIIIIIIIII

(6) Click [Finish] to complete the Projector Messenger Tool setup
wizard.

Projecinr Maria ol - Imstalts i

o =

e el bisked Wigad Foiri duiaimiosbully retalled Papactor
Mpiierey Tool Cleh Frasd b esl the sazaed
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6 Operating Instructions

6.1 Start Application

Select Windows [Start] > [Program] - [Projector Tools] - [Projector Messenger Tool]. A following window
is appeared.

a;- Projector Messeneer Tool

Eda—Fdit Help Send Lock

Menu

Tool Bar Main | Ciscovery Edit

o PROJECTOW

7.168.10.251 v|

Main Tab [ PROJECTOR, i
/ age ON Saved number: Quick
/ Alarm  : ON Sound number: 1

Discovery Tab i
Message file list
Saved number

Edit Tab

| Quick, w | | default. pim w

Display control

Saved number

Cuick. hd [ Display on ] [ Diisplary off ] [ Power on & Display on ]
Clear
@al () Guick, () 8aved number
Skartup Display

Saved number:  Mone

Display time: -

6.2 Quit Application

Select [File] - [Exit] to quit.

It is also possible to quit this software by clicking [x] on the top right
corner of the window.

When the confirmation dialog appears, select [OK] to finish.

Projector Messenger Tool

\_:.:j Are you sure that you want to exit this kool?

| a4 | ’ Cancel

21



6.3 Main Screen

(1) Menu
The functions of the main window are as follows.
Menu Sub-Menu Function
File New The messageltitle boxes are initialized.
Open Load the image file from the PC and display it on Main Screen.
Save Save the image file on Main Screen as a Projector GIF type.
Exit Quit Application.
Edit Undo Undo a previous change.
Cut Selected sentences are cut.
Copy Selected sentences are copied.
Paste Sentences of the clipboard are pasted.
Font color The character color is decided, and it colors.
Font background The character background color is decided, and it colors.
color
Background Color The background color is decided, and it colors.
Send Lock | Send Lock The password lock on the Send button of the Main tab and the Edit
tab.
UnLock Release the lock on the send button of the Main tab and the Edit tab
is released.
Change Password Change the password used to lock the Send button of Main tab and
the Edit tab.
Help About Display the version of this application.
(2) Toolbar
The functions of these icons correspond with the menus are as follows:
Icon Menu
Ei [File]—[New]
= [File]—[Open]
= [File] —[Save]
£ [Edit]—[Cut]
[Edit]—[Copy]

[Edit] —[Paste]

[Edit] —[Font color]

[Edit] —[Font background color]

[Edit]—[Background color]

[Help]—[About]

22




6.4 Select Projector

1) The destination is selected from shown PROJECTOR IP
Address.

In the initial state, "Please select PROJECTOR" is
displayed in this list.

It is because of no registration in the initial state in the
projector list. Please refer to "5.7 Create Projector List" for
details of the registration of the projector list.

6.5 Projector Status

The state of the message and the alarm that selected in
[PROJECTOR IP Address] on the projector are displayed in
[PROJECTOR Status].

23
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6.6 Send Message

2) The file and the saved number are selected in Message file
list, and then click the Send button.

The pjm file is made in the Edit tab. Please refer to "6.10
Create Message" for details.

You can also set “Startup Display” at the same time when you
newly send the message. Please checked “Startup Display”
and select the display time.

[Note]
“Startup Display” is not available at “Quick” display mode.

6.7 Display on/off

1) Please selects the saved number, and clicked the Display
on/off button in “Display control” when you want to display
saved message in the projector.

2) To display high-priority text data, click the “Power on &

Display on” button.

When the “Power on & Display on” button is clicked in on
state, the message is displayed.

When the “Power on & Display on” button is clicked at the
standby, the projector is turned on and then the message is
displayed.

When the “Power on & Display on” button is clicked at the
cooling, the power supply is automatically turned on after the
cooling ends and then the message is displayed.

During the high-priority text data is being displayed, text
display by the scheduling function will not start.

To turn off the high-priority text, click the “Display off” button
or using MY BUTTON that registered MESSENGER.

ke [dé plel  Send Lock
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Please refer to the manuals enclosed with projector for the setting of MY BUTTON and Schedule function.
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6.8 Delete Message

1) Please execute it from the Clear item as shown right to
delete the message preserved in the projector.

All: Quick and all the saved data are deleted.
Quick: Only the Quick is deleted.

Saved Number: Only the saved number specified by the

pull-down menu is deleted.
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6.9 Create Projector List Ein [de beb Send loc .
L I -
1) When the Discovery tab is opened, the projectors B o )
connected with the network are displayed. PR SR BHADDE 100 W11
When the connected projector is not found, please click
the Configuration Manually button. Please refer to 4) for
details of the registration of the projector list.
— [ _rd ]
Ragrtwred FRONCTOR
FROJCTOR Mame MAC Rddess I Baddrass
P OOOE R 000000 [Lige 21 B Se ol i] 192, b8 10, 100
l lﬂq.lpmulf_l' [ Fr—

2) Please select the projector you want to register, and [ e N =1 1)

click the Registration button. It is displayed in Registered I"’_?L’: o ”"fm B B
PROJECTOR. wan === ™
PROJECTON Lt
lﬂf}:lﬁlﬂlﬂr‘ B Addrens F:ldi‘u

3) When you want to delete a projector from the list, click
the Delete button

I Frd |

Fpgeis stion

I Baddrass
192, b8 10, 100
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4) When manually register in the projector list, click the
“Configure Manually” button.

The dialog as shown right is appeared.

Please input IP Address, Mac Address and the password,
and then click OK.

It is registered in the list.

5) Authentication

Please click the projector you want to set the
authentication password, and click the Password button.
The window as shown right is appeared, and set the
password.

27

Fils [t Bk Send Lock

| K | B | T
Mgy [scommry okt
FROECTON Lst
PROECTON Mawe s sdreu 1P 2
PR DOOF DECOCN) OO = (0=00=(K] 190 DAEL 10 10D
[ |
FW&IHF‘. FROCTOR:
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6.10 Create Message

1) Advanced Setting

Please click the Advanced button.
Advanced setting box is appeared. B [dt Hob S Loc
Please refer to the following for each detail. A .-

_ symchwariaston of Serdiiat
.'.:mxwwdm Sopd rumbar | UK (¥ | 192.060010.500 -
[ e e —— I-Ll
| image | J Adearned [L*nq.-waﬂ_ _!'-\-c-‘W'-"_I l w |
<Title Option>
Position: The position where the title is displayed is set.
You can select from Left/Center/Right. T agtion arn
sk Laft - ‘W L -
S Serdrusie I ~ | |

<Message Option> L ol v a1
Style: The display style is selected. ::‘M — e 2 | e
You can select from Scroll/Box/Pop on/Picture | . o
Side. —
“Picture Side” can be selected only when wide | "™ "=~

aspect ratio (16:10) panel model is used. r.m.:::..

Scroll num:  The scroll times is selected.
You can select from Repeat/0-100.
The direct input of the numerical value is s il ceu ]
also possible.

Lagpas] o picture

Scroll speed: The speed of the scroll is selected.
You can select from Slow/Standard/Fast.

Display time: The display time at Box/Pop on is selected.
min : Repeat/0-127min
sec : 0/30sec
The numerical value can be input directly for the item of min.
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<Common Option>
Character font size:  The size of the displayed character is selected.
You can select from Standard/Double size.

Vertical position: The vertical display position is selected.
You can select from Upper/Center/Middle.

Horizontal position: ~ The horizontal display position is selected.
You can select from Left/Right.

Level: The display level is selected.
You can select from Low/Middle/High.

Blink: It is set whether to do the blink when the Pop on display is selected.
You can select from On/Off.

Lapped over picture:
It is set whether to display the message when “Picture Side” texts displayed over the
image.
You can select from Enable/Disable.

<Alarm>
Volume: The volume of the alarm is selected.
You can select from Standard/Double size.
Sound Number: The type of the alarm is selected.
You can select from [none/1/2/3/4].
Loop: The alarm time is selected.
You can select from [endless/1/2/3/4].
Interval: Time from the end of the alarm the next alarm can be selected.

You can select from 0 sec to 5 sec.
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2) Create Message

When you want to color to the character, click the arrow

button at the right of icon " BI~ after the character is
dragged with the mouse and highlighted.

The color selection dialog is appeared. Please select the
color, and click the OK button. Character/character
background color can be set.

A right picture shows the character color of "ess" of
"Message" is set as red and the character background color
of "age" of “Message” is set as blue.

Backeround color El
[
Y

Half transparent

Selection caolor

||

0K, |[ Cancel l
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3) Preview
How the created message is displayed on the screen of the

projector can be confirmed before it is sent. Ele [ beb Sond loc
Please click image button, then the image dialog is |®*H ‘®-g- T
appeared. e T t
The movement such as scroll can be confirmed.
.' |
—
L Pagn fue) 4
s arcas
e e e habpourd ek | Evadrumer QU 3 | 152.160.10.100 v
Ll Charscter degley mocds Serel

' e iN‘-d’lv! | | Cegiany Loy ST | L ol

Style: Scroll

Style: Box/Pop on




Style: Picture Side

6.11 Send Message

Click Send button, and transmit the made message.

You can also set “Startup Display” at the same time when
you newly send the message. Please checked “Startup | ™
Display” and select the display time.

[Note]
> “Startup Display” is not available at “Quick” display mode.

> When “Character Display Mode” is checked, character s
background color and background color is set -
transparent and then only the character is displayed on - Crmived |
the screen. [ 1]

o Sadrumber QU W LRIGOLL0.EO e
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6.12 Save File

(1) Select [File] > [Save] or click = :
- Save File dialog appears

(2) Select the folder to save and enter the file name, and then
Click [Save].
- The file is converted to a transmittable form and saved in
the folder, and the screen is closed.

6.13 Get Message

When you want to get the message data that saved in the
projector, designate saved number and click Get button. The
message saved in the projector is displayed on the Message
box and Title box.
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6.14 Startup Display

This function is not available at “Quick” display mode. You can select the display message from 12 stored
ones by “Saved number”

Please click the Edit button. Startup Display Edit box is

Die [dt Bk Send Lock
appeared. = | T
Please select the saved number, and display time. = — -
Then click OK button. PROCTN P e
192, 500 10358 w
FRONMCTOR Rashe
Hemage: O S runbet <k
Maw ¢ ON S ek | M |
Mesisagn file ke
Srened fusrier
ik w || el gk prp w
] |
Desplay cardrel
S| rugrde
k% | pepiayen | [ splayolt | [ P on b Deplaves |
O
@l Ohak. 7 frond ravber I e
Sartnp Deplay
Tapencd r T e
Depley o (oo |

Startup Display Edit

Saved number
Display time min

| ok |[ Cancel l

S
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6.15 Send Lock
The lock can be put on the Send Button. This function helps to prevent mischief.

1) Lock

B Propetor Messmnams

il [t e | Send Lack |
Click the [Send Lock]. : e . -
The pull-down menu appears. e ey e
Click the [Send Lock] of the first line. iR ;

FRONCTOR Rab

Hemage: O S rumber Jick

Ham o OH Sourd rambei e |
S e bt
Srond fusriber
Gk v |delmpim -
Serd |
Deplary cardred
S i
k% | pepiayen | [ splayolt | [ P on b Deplaves |
Cear
[T R o T S o FPETE .
Starhg Deplay
Syepdrumber  Worw
Dphay e ._J”'
Eile Ede Heb
=X Zared Lock 7
T Chargs Pastwsrd | pa

PROECTOR I Addhess

192, 3601 10. 500 -
FROMCTOR Rabs

Hepuage

Aum
Mianage bl bt

Swend rumber

ek % | deledt o "

=

Doeplry oorirod

Serened b

quck = | copiwron | [ oot | [ Power onbiuplaron |

el sk ) Saved rumbser I-L]

Dot - [e=. |

X

[Send lock] dialog is appeared. Send Lock

Please enter the password and click [OK]. .
ac 2 2EN LICCOn,

[Note] Flease enter the passward in the box belaw,
This application software is not set to the password in the
state of the installation. Please change the password. Password |***** |

Please refer to “3) Change password”.

[ 0K H Cancel ]

Projector Messeneer Tool E

i Syrchrongation of e
» | J The Send button iz locked. ﬂxﬁﬂxmm Sresdranber | %] 1R, 168.00.100 »
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[ Send[Lock] ] is displayed on the [Send] button.

If you click the [ Send[Lock] ] button, the following message is appeared.

You cannot send message data.

[Note]

The [Send] button of the Main tab and the [Send] button of the Edit tab are synchronized.

2) UnLock

Click the [Send Lock].
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The pull-down menu appears.
Click the [UnLock] of the second line.

IInLock

X

[Unlock] dialog is appeared.
Please enter the password and click [OK]. UnLack the Send Bukkan,
[Send] button is released.

Please enter the passwaord in the box below,

Passward |***** |

[ 0K H Cancel ]

R ¥ p——

Ee  Ede Help RS

== Sand Lock 7
Froe Chargs Pastwsrd | pa

PMROECTOR I AdSeds

VA2, 300113, 500 -
FRONCTOR Rubu
s

Al

ssags s bt
Srend rumbar

3) Change password

[ sea ]
Click the [Send Lock]. r— o] (| o]
The pull-down menu appears. =
Click the [Change Password] of the third line. DA Ooud O rusbe o=

Startiug Duplny
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[Change Password] dialog is appeared.

Please enter the current password and the new password, and
then click [OK]. =

[NOte] P
The password is not set on the initial state. Current Password | |

If you change the password, do not input anything in the Mew Password |******* |
[Current Password] and input a new password in the [New
Password]. Then click the [OK] button.

ok, H Cancel ]
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6.16 About this Application

To show the software version, please select [Help] > [About], or click 7 .
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